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ALP LHCSA Statistical Report and Registration Forms on Universal Data Collection System (UDCS) 

Instructions 

 

Submit this report with information regarding the residents your LHCSA (Licensed Home Care Services 

Agency) serves in the ALP (Assisted Living Program) only.   If your LHCSA also serves patients in the 

community, you must also submit the LHCSA Statistical Report.   

 

Please see Attachment A at the end of this document – it contains descriptions to all items on the tool bars 

located on the top of the Report Manager worksheets. 

 

General Information: 

• Enter information in the blank white fields.  All other fields (pink, lavender, and brown) are read-only 

fields.  You can leave white fields blank if you have nothing to report – you do not have to enter zeros. 

• A few fields are required.  If they are left blank, you will not be able to submit the report.  The field 

header will indicate that the field is required. 

• Some fields require a Yes or No answer.  You must double click on the blank field and choose Yes or 

No from the box.   

• Some forms have validation edits to ensure accurate information is collected.  The validation edits are 

described in these instructions. 

 

To Begin: 

 

Once you have downloaded the Report Manager software and report shell (see the separate downloading 

instruction document): 

 

• To start a new report, click on the Start New Report icon or to resume working on a previously saved 

report click on the Open Existing Report icon. 
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Once you have started a new report or opened an existing report, a box will pop up which is the Configure 

Report Organization.  In this box, you will select your organizations name from the drop-down box in the 

organization line.  If your organization is not listed in the drop-down click on the box that states Organization 

Not found In List for further instruction.  In region section you will have to select statewide.  Then click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You will then see a report configuration box.  Click the Next tab in the bottom right corner. 

 

 
  

01/01/2021 – 12/31/2021 
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A second report configuration box will appear once you have completed selecting your counties of service.  

Click Finish in the bottom right hand corner. 

 

                                            

The Save Report Configuration box will come up next to show you where your report is being stored on your 

computer.  You can change where you want it stored by clicking the change location button. 

 

 
 

01/01/2021 – 12/31/2021 

ALP_LHCSA_00_TEST_LHCSA_(000000LC)_STATEWIDE_2021_A00 
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General Information Form 

 

The General Information Form is part of the Report Manager Software and collects information about your 

organization that not only identifies you but enables the submission and certification of your report as well as 

the successful transfer of your data to a data repository.   

 

 

When you open the report, you will receive a pop-up box that requests that you fill in the General Information 

Form.  You must fill in the General Information Form prior to submitting the report. 
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The General Information Form information section will be filled in for you.  You only need to fill in the 

Contact Person and Address sections. 
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Form ALP1 – Agency Form 

 

Form ALP1 - Agency Form collects agency location, contact information and other information.  

 

 
 

 

Agency and Contact Information Section 

All fields in this section, except for NPI number, are required fields.  You will not be able to submit the 

statistical report if this information is not filled in. 

 

 

 

 

 

 

 

  



 

Send questions to hcstatrpts@health.ny.gov   pg. 7 
 

 

Form ALP2 – Resident Form 

 

Form ALP2 - Resident Form collects resident demographic information, including discharges and referrals.  

 

 
 

Some of the totals on this form are automatically calculated – they are the lavender fields. 

 

Residents Section 

Enter information for Resident Census.  Enter the resident census as of December 31 of the report year 

(12/31/2021).  Resident Census means the actual number of individual residents receiving services. 

 

Enter the Unduplicated Resident Count in the next field.  This is the total number of discrete individual 

residents that your agency has served in the year, regardless of the number of admissions and discharges that 

resident may have had.   A resident is only counted once regardless of the number of cases they represent. 

 

To recap, if a resident is receiving care on 12/31/2021 they will be included in the resident census count. If 

they had two admissions during the year, they will count as two cases but as only one unduplicated resident.  

 

Length of Stay Section 

Length of Stay (LOS) information is entered in the next section. LOS is calculated for each episode of care or 

case. Length of stay should be calculated from the date the resident was initially admitted for an episode of 

care, regardless of the year of admission, to the date they were discharged.  For example, if a resident was 
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admitted on 12/30/2021 and discharged on 1/10/2022 her LOS is 12 days.  Count the 2 days in 2021 and the 

10 days in 2022 to arrive at a 12 day LOS.  Residents that were discharged to a hospital or RHCF and 

readmitted to the agency within 30 days with the same illness or diagnosis should NOT be counted in the 

length of stay section. 

 

Validation Edit - The total number of discharges calculated from the LOS entries on row 20 of ALP2 must 

match the total number of discharges calculated from the “Discharged To” section on row 30 of ALP2. 

 

 

Referrals and Discharges Section 

The next section collects resident referral and discharge information. In the “Referred From” column enter the 

number of cases served by your agency that have been referred from each of the designated sources regardless 

of their start of service date. This means that if you are serving a case in 2021 that was referred to your agency 

in 2020, that case should be counted.  Residents that were discharged to a hospital or RHCF and readmitted to 

the agency within 30 days with the same illness or diagnosis should not be counted in the discharge section. 

 

In the “Discharged To” column enter the number of cases discharged during the reporting year to specific 

destinations.  
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ALP3 – Cost Form 

 

ALP3 – Cost Form - collects data on revenue and costs for providing services to residents.   

 

 
 

 

Some of the totals on this form are automatically calculated – they are the lavender fields. 

 

One lines 1 and 2 enter the total number of days of care and total revenue for the report year.   

 

On line 3 the system will calculate the average revenue per day of care by dividing the revenue by the days of 

care.   

 

Enter total costs for the report year on line 4 and the amount of capital related costs on line 5. 

 

• Capital and Related costs are onetime costs for construction, major repairs to real estate owned by the 

agency, etc. 

 

On line 6 the system will calculate Operational Costs by subtracting the amount of capital costs from the total 

costs. 

 

On line 7 the system will calculate the average operational costs per days of care by dividing the operational 

costs by the total number of days of care. 
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Enter the Administrative and General Costs of line 8 

 

• Administrative and General costs are expenses for activities and materials that are used to administer 

your business. Examples are rent, utilities, and office supplies. 

 

On line 9 the system will calculate a percentage by dividing the administrative costs by the operating costs. 

 

On line 10 and 11 enter the costs to provide Home Health Aide and Personal Care Aide services. 

 

On line 12 the system will calculate total HHA and PCA Costs. 

 

On line 13 the system will apply the percentage from Line 9 to the total HHA and PCA costs on line 12.  
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ALP4 – Staff and Wages Form 

 

ALP4 – Staff and Wages Form - collects information by staff type for full time and hourly staff at two 

different dates during the reporting year and the total number of W2s issued, hours worked, wages, and fringe 

benefits.   

 

 
 

 

Some of the totals on this form are automatically calculated – they are the lavender fields. 

 

Enter the number of full-time and hourly staff at your agency on April 1 and October 1. The current definition 

of a full-time staff is someone who works an average of 30 or more hours a week and 130 hours or more per 

month.  The form will calculate the average number of full time and part time staff in the first two lavender 

columns. 

 

Enter the total hours worked for the year.  The form will calculate the number of FTEs represented by these 

hours by dividing the number of hours by 2,080. 

 

Enter total wages paid, and total fringe benefits paid for each staff type.  The amount of wages plus fringe 

benefits will be calculated.   

 

Enter the number of W2s issued during the year for each staff type. 
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ALP9WFC – Workforce Form C 

 

ALP9WFC – Workforce Form C - collects employee benefit information for four types of employees, and 

non-wage supports for all staff.   

 

This form requires some Yes or No Responses.  To answer Yes or No, double click on the white field and the 

following box will pop up. 

 

 
 

Choose your yes or no response to the question, click OK, and it will populate in the field. 
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Employees that receive health insurance or retirement plan benefits through the union, if the agency pays into 

the benefit, should be counted as enrolled in employer-provided health insurance or employer-sponsored 

retirement plan.   

Short-term disability insurance may include the required coverage under New York State law or supplemental 

coverage that the agency offers. 
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ALP10 – Registration Form  

 

ALP10 – Registration Form - collects an attestation that indicates the ALP LHCSA is currently operational 

and serving residents.  If the ALP LHCSA has opened in the past year, you can report on the form that the 

ALP LHCSA is not yet operational and is currently not seeing residents.    

 

Some fields on this form are required fields.  You will not be able to submit the statistical report if this 

information is not filled in. 

 

The appropriate Governing Authority Agent must request that the ALP LHCSA be registered with the 

Department of Health for the upcoming calendar year.  
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Validating the Statistical Report 

 

You may, at any time, validate the sheet you are working on, or validate the entire report.  You must validate 

the report before submitting it. 

 

Go to the top tool bar and click on the drop down box next to the green arrow. 

 

 
 

 
 

 

You can validate a worksheet at any time.  You can also refresh the validation after it’s been done once by 

clicking the refresh circle in the details portion of the report.  Because there are so many worksheets, it may 

be easier to validate each worksheet once you’ve finished it.  The results of the validation are in a table in the 

details section of the worksheet.  The message that says “Rule Passed Validation” is only referring to the cell 

you are on – not the whole worksheet. 

 

 
 

 

IMPORTANT NOTE:  The details section is automatically set up to show all rules.  It’s only an error if there 

is a checkmark in the error box 

 

 
 

 

To see if you have any cells with errors – click on the filter in the details section and change it from “all rules” 

to “critical errors”. 

  

 
 

 

 



 

Send questions to hcstatrpts@health.ny.gov   pg. 16 
 

 

Validations can be done for the worksheet you are on by checking the box that says “Current Worksheet” or it 

can be done for all worksheets by unchecking the box.   

You can fix an error and then re-run the validation by clicking on the refresh circle. 

 
 

 

If you have passed the validation edits you will have no error boxes checked and get a green message that 

says Rule Passed Validation for each cell you choose. 

 

Finalizing the Statistical Report 

 

If you have passed all the validation edits, and you are satisfied with all responses on all forms, click on the 

Finalize Report icon. 

 

 
 

 

Or click Action on the top tool bar and choose “Finalize Report” 

 

 
 

 

A message will come up asking if you are sure you want to save and finalize.  Click Yes. 

A second message will come up directing you to correct errors (if there are any) or letting you know that the 

report has been finalized. 

 

Select a location to save your Finalized Report. Make sure that you are aware of where it is being saved 

(i.e. desktop) as you will need to find the file when you upload it onto the Healthcare Financial Data 

Gateway.  You may wish to make a new folder on your desktop and save it there. 

You will save a PDF of the report, as well as a .pnp file of the report. 

 

The name of the report will be: 

Agency Name_(Agency License Number)_Statewide_2021_A00.pnp 

 

The file you will want to upload will end in “.pnp” 

 

Your report is now ready to be submitted to the Healthcare Financial Data Gateway. 
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Submitting the Finalized ALP LHCSA Statistical Report to the Healthcare Financial Data Gateway 

 

1. Login to the HCS.  

2. Click on Healthcare Financial Data Gateway in My Applications. This will take you to the 

Healthcare Financial Data Gateway main page.  
 

 

 
 

 
3. Click the Submissions tab – the Submissions page will display 
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4. Select ALP LHCSA as the Submission Type and your organization from the Organization list and 

then click the Search button. The Submission page will be expanded. 

 

 
 

 

5. Click the Browse button to display a dialog box that allows you to locate your finalized ALP LHCSA 

Statistical Report. It will have a .pnp file extension.  

6. Once you have selected the file to submit, click the Submit button. 

7. The Submission History section of the Submission page will be updated to reflect the status of the 

submission. 

8. A confirming email message will be sent to the email address listed in the New Submission section of the 

Submission page. 
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Attachment A – Report Tool Bar items 
 

Worksheets 

Worksheets 

 

The Worksheets are listed in the Worksheet Panel which is located on the left side of the application 

window. Worksheets are listed in alphanumeric order by Worksheet name. Click on a Worksheet to view 

that Worksheet in the Matrix Panel. Click on the small arrow key in the top right of the Worksheet Panel to 

collapse or expand the panel. Use the "Windows" menu item to organize your Worksheets in the Matrix 

Panel. 

Title Bar 

Title Bar 

 

The Title Bar is located at the very top of the window and will display the name, version and software build 

number, followed by the name of the active matrix table if a table is currently open. 
 

Menu Bar 

UDCS Menu bar 

 

The following Help Topics will guide you through the menu bar functionality. 

 

File 

The File Menu. 

 
Report Manager: Select Report Manager to return to the Report Manager.  
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New: This command will start a new Report 

 

Open: This command will enable you to open an existing Report 
 

Save: This will save the Report you are working on. 

 

Save Copy To: The Save Copy window will open and enable you to save a copy of your Report to a location 

that you choose. 

Your working report location will remain in the default location: C:\ProgramData\UDCS\report 

 

Print: Two options will be displayed that will enable you to save your Report as a Microsoft Excel 

document or a PDF document. 

For either option, the Select Worksheets window will open. Check the worksheets you wish to export or 

check Select All to check all the worksheets. 

You will be prompted to save the export file to a location you choose. You can then open the file from this 

saved location and print. 

 

Close Report: Closes the Report. You will be prompted to save your data first. 

 

Exit Program: Closes the UDCS software and the Report Manager. You will be prompted to save your data 

first. 
 

Edit 

The Edit Menu 

 
Cut, Copy, Paste, Undo 

 

 

These features will enable you to copy data from one part of your report to another, or from Microsoft Excel 

to your Report with some limitations: 

1) You may copy numeric data to numeric or non-numeric type cells. You may not copy non-numeric data to 

numeric type cells. 

 

2) You may not paste data into read only cells such as targets of formulas. 

 

3) You may select a range of cells to copy. However, when you paste the cells, the range size must match. If 

the range size does not match, you will not be allowed to copy the data. 

For example, if you copy a 5 cell by 5 cell range and try to paste in a 3 cell by 3 cell area, or the area has 

read only cells, you will be alerted to adjust your range. 
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View 

The View Menu 
 

 
 

Report Type: You can choose to Select All Worksheets to display all the worksheets in the Report in the 

Worksheet display panel. 

For Reports that have multiple Report Types, you may choose to select only the worksheets from the 

selected Report Type. 

 

Worksheet Panel (Expand-Collapse): Expands or collapses the worksheets panel. It may be convenient to 

collapse the worksheet panel 

when you are working on a large worksheet and could use extra space to see more of the worksheet. 

 

With the worksheets collapsed you may also click on the arrow icon where the worksheets are collapsed to 

expand the worksheets. 

Previous Worksheet and Next Worksheet: Use these commands to navigate through the worksheets. 

 

Detail Pane (Expand-Collapse): Use this command to expand or collapse the Details panel. This works 

similarly to 

expand-collapse worksheets. 

 

The following menu items will each open a window that will enable you to Export the data as a text file. 

Calculations: A window will open that lists all of the mathematical expressions in the Report. 

 

Text Transfers: Lists all the Text Transfers in the Report. 

Text Transfers consist of a value and a target. Once the value is entered, the target will 

automatically get populated with the same value. 

 

Validation Rules: Lists all the Validation Rules in the Report. 

Validation Rules are conditions that must be met for the report to be completed satisfactorily. 
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Submission Output: This is the XML output of the Report. It lists Report configuration information 

as well as class code/line numbers and the values that were entered for them. 

 

Configure 

The Configure Menu 

 
 

Control Data: Contains information that is required for the Report to be completed correctly and allowed to 

be submitted. 

All required Control Data fields must be complete. Required fields will have a red exclamation point next to 

them. 

When you open the Report, you will be alerted if the Control Data information is not completely filled out. 

 

Report Settings / Report Types: These menu items are merely instructions to remind you what to do f you 

have created your report using the wrong configuration information, such as the wrong Report Type or wrong 

Region. Click on the File menu to Start a New Report. Select the correct settings and then transfer your data 

from the incorrect Report to the new Report. 

Action 

The Action Menu 
 

 

Validation Method: Current Worksheet or Entire Report. 

In order to Finalize the Report for Submission you must run it through the validation process. You can 

validate to check only the current Worksheet, or you can run Validation for the entire Report. You must 

Validate the entire Report in order to pass Validation and have a Finalized Report that is ready to submit. 

 

Start Validating/Stop Validating: Once you have selected to validate the current Worksheet or the entire 

Report you can 

select the Start Validating item. For larger Reports, you may choose to Stop Validating at any time. 
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Notepad 

The Notepad Menu 

 

This is a scratch pad to keep notes and provide additional information while you complete your report. Click 

the File menu and then Save to save Notes to your Report. 

Use the File and Edit menu as you would a typical text editor. 

Windows 

The Windows Menu 

 

Use the Windows commands to arrange the Worksheets to your satisfaction. 

Select the Worksheets command to see a list of opened Worksheets. You may select an open Worksheet to 

bring it to the front of the Report. 
 

 

Search 

The Search Menu 

 

Enter what you would like to search for in the Search box and click the Search button. 

All results that match your Search criteria will be listed below. You may choose to Search 

the Current Worksheet or All Worksheets by toggling the radio buttons at the bottom of the window. 

Help 

The Help Menu 

 

View Documentation will open the Help File that you are currently reading. 
 

 

Click About to open the following window. This information contains details about the Report you have open 

as well as the versions of the software and files being used. 
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Icon Menu 

 
Icon Menu 
 
 
 
 

        Open the Control Data Form. 
 
 
 
 

         Start a New Report. 
 
 
 

       Open an Existing Report. 
 
 
 
 

        Save the Report. 
 
 
 
 

        Close the Report. 
 
 
 
 

        Validate the Current Worksheet or the Entire Report. 
 
 
 
 

        Stop the Validation process. 
 
 
 
 

        Finalize the Report. 
 
 
 
 

        Open Notepad. 
 
 
 
 

        Open the Previous Worksheet. 
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         Open the Next Worksheet. 

 
 
 
 

         Export the Worksheet as a PDF document. 
 
 
 
 
 

         Export the Worksheet as an Excel file. 
 

          Open the Search Window. 
 

 


